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- There are common steps that you can take to solve 

problems:  

(1) Construct a hypothesis: 

• A hypothesis is an educated guess about how things 

work. 

• Constructing a hypothesis is an attempt to answer your 

question with an explanation that can be tested. 

(2) Test your hypothesis: 

• Do not conduct any tests that are not safe! 

(3) Check if your test is successful or not: 

• Break down the complex problem into small sections, 

then solve it step-by-step. 

• If you have a group of people solving a problem, assign 

each person a section. 

--------------------------------------------------------------------------- 

 

 

 

 

 

• Problem-Solving Skills.Lesson (2):
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Microsoft 365 includes different options, such as 

 

 

PowerPoint  Word  Publisher 

(1) A margin: 

• It is the space left around the edges of your poster or 

billboard. 

• A 25-mm margin will help design a good poster. 

(2) Font size: 

• If you choose a small font size, your audience will strain 

to read the information. 

• If you choose a too-large font size, you'll have to limit 

the amount of information. 

(3) Font type: 

• Sometimes, simple fonts are better. 

• A complicated or decorative font is distracting and hard 

to read.  

(4) Colors: 

• Choose no more than three colors, when designing a 

poster. 

•Presenting Information to Others.Lesson (3)
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• Use bold colors for information you want to emphasize. 

(5) Images: 

• Use clear, good-quality, and appropriate images to the 

content you are sharing. 

------------------------------------------------------------------------- 

 

 

- Algorithm: It's a series of steps that explain how to do a 

task.  

• When you make a meal, you follow a recipe, that is a 

type of algorithm! 

• When you type keywords, the search engine uses 

algorithms to provide results. 

• Computers and applications use algorithms to perform 

specific tasks. 

------------------------------------------------------------------------- 

 

 

- Coding: It's the writing of multiple algorithms to make a 

complete program. 

• Online animations, movies, and online games are 

created using coding! 

•AlgorithmLesson (5)

• The Principles of Coding.Lesson (6)



 

6 
 

• Computers, like people, speak different languages. 

• There are many websites, like Code.org, that can help 

you learn to code. 

• You can create mazes on Code.org. 

------------------------------------------------------------------------- 

 

 

- Microsoft Paint: It is a popular graphics editor that will 

help you create your own drawings or edit images on 

computers.  
- To open Microsoft Paint, click on the Start-up Menu, 

then Accessories, then click on MS Paint. 

- The top of the screen is like Word and Excel. 

- Menu Bar: It includes options for opening, saving, and 

editing features. 

- Toolbox: It includes tools that you need to make your 

drawing. 

- You can cut a part of an image using the cropping tool. 

- You can change the size or direction of the photo in MS 

paint. 

- You can fill colors using the color options. 

•Graphic ArtLesson (7)
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- Microsoft Word also offers graphic tools to create a 

graphic design.  
- Click on the "Insert" menu bar to see the different 

options, such as: Shape, Icons, 3D Models and Smart Art. 

------------------------------------------------------------------------- 

 

 

- You can use Microsoft PowerPoint to create 

presentations that include:  
(1) Text    (2) Images 

(3) Animations  (4) Special effects 

- At the top of the PowerPoint screen, you will see a Menu 

Bar. 

- Use this first slide to name the title and subtitle of your 

presentation. 

- In the subtitle box, you can also include your name. 

- A slide is a presentation page that contains text and 

images. 

- On the left side of the screen, you will see a thumbnail or 

preview image of each slide you're creating. 

- To choose the layout of each slide, click the "Layout" 

icon on the "Home" menu. 

• Creating a PowerPoint PresentationLesson (8)
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1- Design: It includes background colors. 

2- Draw: It includes drawing tools. 

3- Transitions: It includes visual effects to use between 

each slide. 

4- Animations: It includes animated effects for each slide. 

5- Slide Show: It makes you decide how you'd like to 

present and time each slide. 

Note: 

• You can view the presentation by clicking the "View 

Show" icon or the F5 key on the keyboard. 

• Avoid wordy paragraphs or sentences. 

• Be sure to use a font size and style that are readable. 

• Use relevant images instead of text whenever possible. 

--------------------------------------------------------------------- 

Choose the correct answer:  

1- Microsoft 365 package contains ………....  

a- MS Word    b- Paint    

c- Google Chrome  d- a & b 

2- The amount of empty space between the edges of a 

poster is called the ………....  

a- font   b- margin  c- image options  d- border 
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3- Make sure to choose a font size that is …….…. when 

designing a poster or digital billboard 

a- very small   b- easy to read  

c- very large   d- complicated 

4- To design a digital poster or billboard, you will 

need………..  

a- a computer  b- GPS   c- TV   d- a router 

5- If you use …… font size, you will have to limit the 

amount of information. 

a- small    b- too big  c- suitable  d- tiny 

6- When designing a poster, sometimes, ………….. fonts 

are better. 

a- decorative   b- simple  c- complicated     d- a & c 

7- Use …….... images to the content you are sharing in the 

poster. 

a- clear    b- low-quality  

c- inappropriate  d-irrelevant 

8- Use ……….. for the information you want to emphasize. 

a- small font size  b- bold colors   

c- tiny font   d- a & c 
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9- ……… are a set of arranged steps to solve a problem. 

a- Search engines   b- Algorithms  

c- Keywords    d- Sentences 

10- You can type …….... into the search engine to search 

for information online. 

a- keyboards    b- algorithms  

c- keywords    d- symbols 

11- When you prepare a meal, you follow a recipe; this is 

considered as a/an …..… 

a- augmented reality   b- algorithm  

c- digital blogging    d- order 

12- An algorithm is a/an ……... to do a task. 

a- series of steps    b-software  

c- application    d- hardware 

13- ……….. is writing multiple algorithms to create a 

complete program.  

a- Windows   b-MS Word   c-Coding  d-Paint  

14- You can learn coding and create mazes using many 

websites, such as …………  

a- Code.org     b- Vlaby   

c- Mapmaker interactive  d- Facebook 
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15- ……... Like people, speak different languages 

a- Cars   b- Animals  c- Rocks   d- Computer 

16- You can create animations, movies, and games 

using……..  

a- Excel   b- coding  c- Word   d- Google 

17- You can …….... at Code.org 

a- learn coding    b-create mazes  

c- eat breakfast    d- a and b  

18- The first step in problem solving is ……...  

a- hypothesis testing   b- asking your teacher  

c- hypothesis building        d- none of the previous answers 

19- ……..… is an attempt to answer your question with 

an explanation that can be tested. 

a- Hypothesis building    b- Hypothesis testing  

c- Solving problems        d- None of the previous answers 

20- A/An …..is an educated guess about how things work. 

a- algorithm   b- maze   c- hypothesis   d-test 

21- To solve a specific problem, you must …..the problem. 

a- leave   b- break down  c- prepare  d- ignore 
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22- You should be careful when solving problems that 

may pose a risk to you during the ………… step. 

a- hypothesis building   b- hypothesis testing  

c- data collection    d- reporting 

23- You watched your teacher make sure that the 

keyboard cable is connected to the place designated for 

it; this means that he is taking the ……… step. 

a- hypothesis building   b- hypothesis testing  

c- digital footprint   d- a and b 

24- When you prepare a meal, you follow a/an …………. 

a- recipe  b- algorithm  c- a & b   d- letter 

25- …… is one of the sites that helps learn programming. 

a- Code.org b- EKB  c- Google      d- Wikipedia 

26- Microsoft ……..… is a popular graphics editor. 

a- Word    b- Excel   c- Paint         d- Facebook 

27- The top of the screen of Microsoft Paint is like……..…  

a- MS Word   b- MS Excel   

c- Skype    d- both a and b 

28- Microsoft Paint is a popular …………. editor. 

a- features   b- graphics  c- video   d- word 

29- In Paint, you can …………  

a- draw    b- add text  c- search   d- both a and b 
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30- The …….... in MS Paint includes options for opening, 

saving files, and editing features.  

a- Toolbox  b- Layout  c- Edit bar       d- Menu bar 

31- You can click on the “……..…” in MS word to see the 

different options, such as icons and shapes.  

a- Insert    b- Draw   c- Edit   d- Design 

32- The ……… includes all tools that you will need to 

make your drawing. 

a- Menu bar   b- Colors  c- Tool box  d- Word 

33- MS Word contains many options, including …….…  

a- shapes   b- 3D models  c- coding  d- a & b 

34- You can select and cut certain parts of the image in 

Paint using the …..…  

a- crop tool  b- color fill tool  c- brush tool      d- a & b 

35- To view the image  in a larger size in paint  program 

use …….…  

a-     b-    c-    d-  

36- To present your ideas in a way that is characterized 

by the effects of sound and movement, you need to use 

………… program. 

a- MS Word   b- paint  c- PowerPoint       d- MS Excel 
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37- A ……….. is a presentation page that contains your 

text and images. 

a- billboard   b- slide   c- sheet   d-cell 

38- To add a new slide in the presentation, press Home 

tab, then ……..…  

a- insert   b-new Slide   c- slide Show   d- edit 

39- Microsoft PowerPoint is used to create presentations 

that include …….…  

a- text and animations   b- special effects  

c- both a and b    d- none of them 

40- The ………… is located at the top of the opening 

screen of the program. 

a- Menu bar   b- Slide   c- Image   d- Text 

41- To insert pictures into your presentation, click …….. 

then pictures. 

a- slide show   b- transitions      c- insert  d- animation  

42- You can run your PowerPoint presentation through 

the ………… key from the keyboard.  

a- F3    b- F4    c- F5   d- F6 

43- You should use the first slide to name the ……… of 

your presentation.  

a- title   b- subtitle  c-both a & b  d- conclusion 
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44- You can change background colors in PowerPoint 

from the ……….. tab. 

a- Draw   b- Design  c- Transition  d- Animation 

45- Using ……… tab in PowerPoint, we can choose a 

visual effect to use between each slide. 

a- Draw   b- Slide show   c- Transition  d- Design 

46- To prepare a good presentation you have to ….…  

a- link the images in the presentation to the topic. 

b- add untrusted opinions and information to the 

presentation. 

c- add too many fonts and colors to the presentation. 

d- use only one font. 

 

47- ….… tab includes animation effects for each slide.  

a- Draw   b- Animation   c- Transition   d- Review 

 

 

Put (✓)  or (×):  

1- Many daily activities, like giving directional signals, are 

considered types of algorithms.    ( ) 

2- When you solve a problem in math class, this is 

considered a type of algorithm.    ( ) 

3- Algorithms help us determine which results are most 

relevant to our keywords.     ( ) 
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4- An algorithm is a series of steps that explains how to 

perform a task.        ( ) 

5- Coding is the writing of multiple algorithms to make a 

complete program.       ( ) 

6- You can use programming codes to identify the paths 

needed to reach your goal.     ( ) 

7- Computers, like humans, use different languages. ( ) 

8- The video games that you play online were made by 

coding.         ( ) 

9- There are many websites, such as Facebook.com, that 

can help you learn different programming languages. ( )  

10- The animations and movies you watch online are 

designed by Excel.        ( ) 

11- The first step in problem solving is hypothesis testing.  

( ) 

12- When making a guess to solve a problem, this guess is 

called the hypothesis.       ( ) 

13- When testing your hypothesis, it is necessary not to do 

any test that puts you at risk.      ( ) 

14- Problems should not be divided into small parts so as 

not to be difficult to solve.      ( ) 

15- Any big problem should be left without solving. ( ) 
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16- It is important to break complex problems into small 

parts when solving them.      ( ) 

17- If you solve a problem with your colleagues, assign 

each person one section.       ( ) 

18- It is important to crowd the edges of your billboard.

           ( ) 

19- Having a 25-mm margin helps you create a well-

designed poster.       ( ) 

20- Make sure to choose a font size that is easy to read. (  ) 

21- If you choose a big font size’ your audience will have 

to strain to read the information.    ( ) 

22- We need images and colors to design a poster or a 

digital billboard.       ( ) 

23- More decorative fonts in your poster are not 

preferable when making it.      ( ) 

24- It is better to use more than three colors in the poster.

           ( ) 

25- Considering the background color is not important 

when choosing the font color.     ( ) 

26- You should choose too small font size on poster for 

easy reading.        ( ) 

27- You can't learn coding online.    ( ) 
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28- Search engines use digital map databases to provide 

directions.          ( ) 

29- To open Paint, click on Accessories, then Start-up 

menu.          ( ) 

30- The brush tool is used in Paint to enlarge parts of the 

image.          ( ) 

31- The upper part of the Paint program is similar to 

Word and Excel.       ( ) 

32- The icon      in Paint is used to view the image in a 

larger size.         ( ) 

33- One of the disadvantages of Paint is that it does not 

include a toolbox.        ( ) 

34- In Paint, you can add text to an image.  ( ) 

35- Microsoft Paint allows you to change the size or 

direction of the photo.      ( ) 

36- The Insert menu bar in MS Word includes graphic 

tools to make drawings.      ( ) 

37- Use the cut tool in the paint toolbar to fill colors. ( ) 

38- One of the things to consider when preparing a 

presentation is to avoid writing long paragraphs. ( ) 

39- PowerPoint is used to design presentations with texts 

only.           ( ) 
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40- Presenters often include their names in the subtitle 

box.          ( ) 

41- You cannot insert images you created in Paint into 

your PowerPoint presentation.    ( ) 

42- On the left side of the PowerPoint screen, you can see 

a thumbnail of each slide you’re creating.  ( ) 

43- You can choose the background colors for each slide 

under the design options.      ( ) 

44- PowerPoint provides the ability to add animation to 

slides.          ( ) 

45- Microsoft Paint is a program used for editing 

pictures.         ( ) 

46- Microsoft Word doesn’t have any graphic tools. ( ) 

 

Complete the following using the words between the 

brackets: 

(Algorithm – instructions – keywords – Computers – 

recipe) 

1- When you prepare a meal, you follow a ….…...; this is a 

type or algorithm 

2- …..… is a series of steps that explain how to perform a 

task. 
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3- ……..… and applications do algorithms to perform 

functions. 

4- A recipe is an algorithm which includes a set of ……… 

for making a meal. 

5- Every time you enter ………… that about your research 

in a search browser, it uses certain algorithms to give you 

the results. 

------------------------------------------------------------------------ 

(fonts - margin – three – bold – Microsoft 365) 

1- The empty space between the edges of the billboard is 

called ………..…  

2- It is better not to use more than … colors in the poster. 

3- ………… includes different options, such as PowerPoint 

and Word. 

4- Sometimes, simple ……..… are better 

5- Use ……..… colors for the information you want to 

emphasize. 

 

 

 

 

------------------------------------------------------------------ 
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(food recipe -coding- instructions-algorithms -Computers) 

1- You can create animations, movies, and games using...... 

2- A ………… is a type of algorithm. 

3- Coding is the writing of multiple ………….. to make a 

complete program. 

4- …………, like people, use different programming 

languages for communication. 

5- A recipe includes a set of ………… to make a meal, 

which is a type of algorithm. 

------------------------------------------------------------------------- 

(Paint – slide – animations and effects – Toolbox – Draw) 

1- Microsoft PowerPoint can create presentations that 

include …………  

2- In MS Paint, the ………… includes tools that you need 

to make your drawings. 

3- A ……….. is a presentation page that contains texts and 

images. 

4- ……….. tab in PowerPoint includes drawing tools. 

5- ……….. is a Microsoft program used to edit images on 

computers. 

------------------------------------------------------------------------- 
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Choose from column (A) what suits it in column (B): 

Column (A) Column (B) 

1-  a- To write with a pencil. 

2-   
b- To view the image or figure in a 

large size. 

3-  c- Spray icon with coloring brush. 

4-  d- To write a text. 

5-  e- To fill the color into the shape. 

 

(1) ………(2) ………. (3) ……… (4) ……… (5) ……….. 

------------------------------------------------------------------------ 

Column (A) Column (B) 

1-  

a- It’s used to design presentations that 

include text and animation effects. 

2-  

b- It’s a popular graphics editor. 

3-   

c- It’s used to create spreadsheets 

including rows and columns. 

4-  
d- It’s used to write reports and add 

some pictures. 

 

(1) ………(2) ………. (3) ……… (4) ………  
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Choose the correct answer:  

1- When creating a poster or billboard be sure to …....   

a- Choose a small font size 

b- Choose complicated font size 

c- Choose too big font size    

d- Choose suitable font size and type 

2- To use images in the billboard it must be ……...  

a- appropriate images and sizes  b- not clear images 

c- very small images   d- bad quality images 

3- If you and your team faced a problem, to solve it …....  

a- assign each person section of it 

b- assign the problem to one of them 

c- only you solve the problem 

d- keep the problem without solving 

4- To facilitate solve a big problem ………  

a- breaking down the problem into smaller section 

b- don’t solve it 

c- don’t assign the roles to team group 

d- assign one solve 
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5- You can type multiple algorithms to create a complete 

program by ……...  

a- programming  b- screen  c- keyboard  d- mouse 

6- The ……… program can recognize if the words typed 

correctly or not.  

a- word   b- photoshop   c- excel   d- flash 

7- The ………… program is one of the famous programs 

in editing images 

a- Paint   b- Word   c- Facebook   d- Twitter 

8- The ……..… program used to create presentations that 

include text and special effects. 

a- PowerPoint  b-Word  c-Facebook   d-Twitter  

------------------------------------------------------------------------- 

Put (✓)  or (×):  

1- Computers and applications need algorithms to work.( )  

2- Coding is used in animation, movies and online games 

you have played.        ( ) 

3- Word processing program verify that the words you 

type is correct.         ( ) 

4- Coding is the writing of multiple algorithms to make a 

complete program.        ( ) 
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5- Code.org can help you learn to code using different 

coding languages.       ( ) 

6- Paint program is one of the famous programs used in 

editing images.         ( ) 

7- Microsoft PowerPoint used to create presentations that 

include text and special effects.    ( ) 

8- Microsoft paint allows design image and save it. ( ) 

9- The slide is a presentation page that contains text and 

images.          ( ) 

10- The toolbox includes all the tools that you will need to 

make your drawing.       ( ) 

11- Microsoft PowerPoint allows you to insert new slide to 

your presentation.        ( ) 

12- You must be sure that your computer is updated to 

download Microsoft office 365 bundle.   ( ) 

13- Be sure to choose a font size to your poster or 

billboard that is easy to read.      ( ) 

14- Choice a complicated font size in the poster make it 

easy to read.        ( ) 

15- When making a poster or billboard you must be sure 

that the audience will be able to easily see your 

information.        ( ) 

16- Images should be suitable in sense terms of the 

content you are sharing.      ( ) 
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Choose the correct answer:  

1- Microsoft 365 package contains ………....  

a- MS Word    b- Paint    

c- Google Chrome  d- a & b 

2- The amount of empty space between the edges of a poster 

is called the ………....  

a- font   b- margin  c- image options  d- border 

3- Make sure to choose a font size that is …….…. when 

designing a poster or digital billboard 

a- very small   b- easy to read  

c- very large   d- complicated 

4- To design a digital poster or billboard, you will 

need………..  

a- a computer  b- GPS   c- TV   d- a router 

5- If you use …… font size, you will have to limit the amount 

of information. 

a- small    b- too big  c- suitable  d- tiny 

6- When designing a poster, sometimes, ………….. fonts 

are better. 

a- decorative   b- simple  c- complicated     d- a & c 

7- Use …images to the content you are sharing in the poster. 

a- clear    b- low-quality  

c- inappropriate  d-irrelevant 
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8- Use ……….. for the information you want to emphasize. 

a- small font size  b- bold colors   

c- tiny font   d- a & c 

9- ……… are a set of arranged steps to solve a problem. 

a- Search engines   b- Algorithms  

c- Keywords    d- Sentences 

10- You can type …….... into the search engine to search 

for information online. 

a- keyboards    b- algorithms  

c- keywords    d- symbols 

11- When you prepare a meal, you follow a recipe; this is 

considered as a/an …..… 

a- augmented reality   b- algorithm  

c- digital blogging    d- order 

12- An algorithm is a/an ……... to do a task. 

a- series of steps    b-software  

c- application    d- hardware 

13- ……….. is writing multiple algorithms to create a 

complete program.  

a- Windows   b-MS Word   c-Coding  d-Paint  

14- You can learn coding and create mazes using many 

websites, such as …………  

a- Code.org     b- Vlaby   

c- Mapmaker interactive  d- Facebook 
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15- ……... Like people, speak different languages 

a- Cars   b- Animals  c- Rocks   d- Computer 

16- You can create animations, movies, and games 

using……..  

a- Excel   b- coding  c- Word   d- Google 

17- You can …….... at Code.org 

a- learn coding    b-create mazes  

c- eat breakfast    d- a and b  

18- The first step in problem solving is ……...  

a- hypothesis testing   b- asking your teacher  

c- hypothesis building        d- none of the previous answers 

19- ……..… is an attempt to answer your question with an 

explanation that can be tested. 

a- Hypothesis building    b- Hypothesis testing  

c- Solving problems        d- None of the previous answers 

20- A/An …..is an educated guess about how things work. 

a- algorithm   b- maze   c- hypothesis   d-test 

21- To solve a specific problem, you must …..the problem. 

a- leave   b- break down  c- prepare  d- ignore 
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22- You should be careful when solving problems that may 

pose a risk to you during the ………… step. 

a- hypothesis building   b- hypothesis testing  

c- data collection    d- reporting 

23- You watched your teacher make sure that the 

keyboard cable is connected to the place designated for 

it; this means that he is taking the ……… step. 

a- hypothesis building   b- hypothesis testing  

c- digital footprint   d- a and b 

24- When you prepare a meal, you follow a/an …………. 

a- recipe  b- algorithm  c- a & b   d- letter 

25- …… is one of the sites that helps learn programming. 

a- Code.org b- EKB  c- Google      d- Wikipedia 

26- Microsoft ……..… is a popular graphics editor. 

a- Word    b- Excel   c- Paint         d- Facebook 

27- The top of the screen of Microsoft Paint is like……..…  

a- MS Word   b- MS Excel   

c- Skype    d- both a and b 

28- Microsoft Paint is a popular …………. editor. 

a- features   b- graphics  c- video   d- word 

29- In Paint, you can …………  

a- draw    b- add text  c- search   d- both a and b 
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30- The …….... in MS Paint includes options for opening, 

saving files, and editing features.  

a- Toolbox  b- Layout  c- Edit bar       d- Menu bar 

31- You can click on the “……..…” in MS word to see the 

different options, such as icons and shapes.  

a- Insert    b- Draw   c- Edit   d- Design 

32- The ……… includes all tools that you will need to make 

your drawing. 

a- Menu bar   b- Colors  c- Tool box  d- Word 

33- MS Word contains many options, including …….…  

a- shapes   b- 3D models  c- coding  d- a & b 

34- You can select and cut certain parts of the image in 

Paint using the …..…  

a- crop tool  b- color fill tool  c- brush tool      d- a & b 

35- To view the image  in a larger size in paint  program 

use …….…  

a-     b-    c-    d-  

36- To present your ideas in a way that is characterized by 

the effects of sound and movement, you need to use 

………… program. 

a- MS Word   b- paint  c- PowerPoint       d- MS Excel 
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37- A ……….. is a presentation page that contains your 

text and images. 

a- billboard   b- slide   c- sheet   d-cell 

38- To add a new slide in the presentation, press Home tab, 

then ……..…  

a- insert   b-new Slide   c- slide Show   d- edit 

39- Microsoft PowerPoint is used to create presentations 

that include …….…  

a- text and animations   b- special effects  

c- both a and b    d- none of them 

40- The ………… is located at the top of the opening screen 

of the program. 

a- Menu bar   b- Slide   c- Image   d- Text 

  

41- To insert pictures into your presentation, click …….. 

then pictures. 

a- slide show   b- transitions      c- insert  d- animation  

42- You can run your PowerPoint presentation through 

the ………… key from the keyboard.  

a- F3    b- F4    c- F5   d- F6 
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43- You should use the first slide to name the ……… of 

your presentation.  

a- title   b- subtitle  c-both a & b  d- conclusion 

44- You can change background colors in PowerPoint 

from the ……….. tab. 

a- Draw   b- Design  c- Transition  d- Animation 

45- Using ……… tab in PowerPoint, we can choose a visual 

effect to use between each slide. 

a- Draw   b- Slide show   c- Transition  d- Design 

46- To prepare a good presentation you have to ….…  

a- link the images in the presentation to the topic. 

b- add untrusted opinions and information to the 

presentation. 

c- add too many fonts and colors to the presentation. 

d- use only one font. 

 

47- ….… tab includes animation effects for each slide.  

a- Draw   b- Animation   c- Transition   d- Review 

 

 

Put (✓)  or (×):  

1- Many daily activities, like giving directional signals, are 

considered types of algorithms.    (✓ ) 

2- When you solve a problem in math class, this is 

considered a type of algorithm.    (✓ ) 
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3- Algorithms help us determine which results are most 

relevant to our keywords.     (✓ ) 

4- An algorithm is a series of steps that explains how to 

perform a task.        (✓ ) 

5- Coding is the writing of multiple algorithms to make a 

complete program.       (✓ ) 

6- You can use programming codes to identify the paths 

needed to reach your goal.     (✓ ) 

7- Computers, like humans, use different languages. (✓ ) 

8- The video games that you play online were made by 

coding.         (✓ ) 

9- There are many websites, such as Facebook.com, that 

can help you learn different programming languages. (× )  

10- The animations and movies you watch online are 

designed by Excel.        (× ) 

 

11- The first step in problem solving is hypothesis testing.  

(× ) 

12- When making a guess to solve a problem, this guess is 

called the hypothesis.       (✓ ) 
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13- When testing your hypothesis, it is necessary not to do 

any test that puts you at risk.      (✓ ) 

14- Any big problem should be left without solving. (× ) 

15- It is important to break complex problems into small 

parts when solving them.      (✓ ) 

16- If you solve a problem with your colleagues, assign 

each person one section.       (✓ ) 

17- It is important to crowd the edges of your billboard.

           (× ) 

18- Having a 25-mm margin helps you create a well-

designed poster.       (✓ ) 

19- Make sure to choose a font size that is easy to read.(✓  ) 

20- If you choose a big font size’ your audience will have to 

strain to read the information.    (× ) 

21- We need images and colors to design a poster or a 

digital billboard.       (✓ ) 

22- More decorative fonts in your poster are not preferable 

when making it.        (✓ ) 

23- It is better to use more than three colors in the poster.

           (× ) 
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24- Considering the background color is not important 

when choosing the font color.     (× ) 

25- Use clear, good quality and appropriate images when 

creating a poster.       (✓ ) 

26- You can't learn coding online.    (× ) 

27- Search engines use digital map databases to provide 

directions.          (✓ ) 

28- To open Paint, click on Accessories, then Start-up 

menu.          (× ) 

29- The brush tool is used in Paint to enlarge parts of the 

image.          (× ) 

30- The upper part of the Paint program is similar to Word 

and Excel.         (✓ ) 

31- The icon      in Paint is used to view the image in a larger 

size.           (✓ ) 

32- One of the disadvantages of Paint is that it does not 

include a toolbox.        (× ) 

33- In Paint, you can add text to an image.  (✓ ) 

34- Microsoft Paint allows you to change the size or 

direction of the photo.      (✓ ) 
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35- The Insert menu bar in MS Word includes graphic 

tools to make drawings.      (✓ ) 

36- Use the cut tool in the paint toolbar to fill colors. (× ) 

37- One of the things to consider when preparing a 

presentation is to avoid writing long paragraphs. (✓ ) 

38- PowerPoint is used to design presentations with texts 

only.           (× ) 

39- Presenters often include their names in the subtitle box.

          (✓ ) 

40- You cannot insert images you created in Paint into 

your PowerPoint presentation.    (× ) 

41- On the left side of the PowerPoint screen, you can see a 

thumbnail of each slide you’re creating.  (✓ ) 

42- You can choose the background colors for each slide 

under the design options.      (✓ ) 

43- PowerPoint provides the ability to add animation to 

slides.          (✓ ) 

44- Microsoft Paint is a program used for editing pictures.

           (✓ ) 

45- Microsoft Word doesn’t have any graphic tools. (× ) 

 



 

14 
 

 

 

 

 

Complete the following using the words between the 

brackets: 

(Algorithm – instructions – keywords – Computers – 

recipe) 

1- When you prepare a meal, you follow a recipe; this is a 

type or algorithm 

2- Algorithm is a series of steps that explain how to perform 

a task. 

3- Computers and applications do algorithms to perform 

functions. 

4- A recipe is an algorithm which includes a set of 

instructions for making a meal. 

5- Every time you enter keywords that about your research 

in a search browser, it uses certain algorithms to give you 

the results. 

 

 

------------------------------------------------------------------------ 
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(fonts - margin – three – bold – Microsoft 365) 

1- The empty space between the edges of the billboard is 

called margin 

2- It is better not to use more than three colors in the poster. 

3- Microsoft 365 includes different options, such as 

PowerPoint and Word. 

4- Sometimes, simple fonts are better 

5- Use bold colors for the information you want to 

emphasize. 

(food recipe -coding- instructions-algorithms -Computers) 

1- You can create animations, movies, and games using 

coding 

2- A food recipe is a type of algorithm. 

3- Coding is the writing of multiple algorithms to make a 

complete program. 

4- Computers like people, use different programming 

languages for communication. 

5- A recipe includes a set of instructions to make a meal, 

which is a type of algorithm. 

 

 

 

 

 

------------------------------------------------------------------------- 
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(Paint – slide – animations and effects – Toolbox – Draw) 

1- Microsoft PowerPoint can create presentations that 

include animations and effects 

2- In MS Paint, the Toolbox includes tools that you need to 

make your drawings. 

3- A slide is a presentation page that contains texts and 

images. 

4- Draw tab in PowerPoint includes drawing tools. 

5- Paint is a Microsoft program used to edit images on 

computers. 

------------------------------------------------------------------------ 

Choose from column (A) what suits it in column (B): 

Column (A) Column (B) 

1-  a- To write with a pencil. 

2-   
b- To view the image or figure in a 

large size. 

3-  c- Spray icon with coloring brush. 

4-  d- To write a text. 

5-  e- To fill the color into the shape. 

 

(1) d    2) e (3) c     (4) a      (5) b 

------------------------------------------------------------------------ 
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Column (A) Column (B) 

1-  

a- It’s used to design presentations that 

include text and animation effects. 

2-  

b- It’s a popular graphics editor. 

3-   

c- It’s used to create spreadsheets 

including rows and columns. 

4-  
d- It’s used to write reports and add 

some pictures. 

 

(1) d (2) c  (3) a  (4) b 
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19 
 

Choose the correct answer:  

1- When creating a poster or billboard be sure to …....   

a- Choose a small font size 

b- Choose complicated font size 

c- Choose too big font size    

d- Choose suitable font size and type 

2- To use images in the billboard it must be ……...  

a- appropriate images and sizes  b- not clear images 

c- very small images   d- bad quality images 

3- If you and your team faced a problem, to solve it …....  

a- assign each person section of it 

b- assign the problem to one of them 

c- only you solve the problem 

d- keep the problem without solving 

4- To facilitate solve a big problem ………  

a- breaking down the problem into smaller section 

b- don’t solve it 

c- don’t assign the roles to team group 

d- assign one solve 
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5- You can type multiple algorithms to create a complete 

program by ……...  

a- programming  b- screen  c- keyboard  d- mouse 

6- The ……… program can recognize if the words typed 

correctly or not.  

a- word   b- photoshop   c- excel   d- flash 

7- The ………… program is one of the famous programs in 

editing images 

a- Paint   b- Word   c- Facebook   d- Twitter 

8- The ……..… program used to create presentations that 

include text and special effects. 

a- PowerPoint  b-Word  c-Facebook   d-Twitter  

------------------------------------------------------------------------- 

Put (✓)  or (×):  

1- Computers and applications need algorithms to work.( ✓)  

2- Coding is used in animation, movies and online games 

you have played.        (✓ ) 

3- Word processing program verify that the words you type 

is correct.          (✓ ) 

4- Coding is the writing of multiple algorithms to make a 

complete program.        (✓ ) 
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5- Code.org can help you learn to code using different 

coding languages.       (✓ ) 

6- Paint program is one of the famous programs used in 

editing images.         (✓ ) 

7- Microsoft PowerPoint used to create presentations that 

include text and special effects.    (✓ ) 

8- Microsoft paint allows design image and save it. (✓ ) 

9- The slide is a presentation page that contains text and 

images.          (✓ ) 

10- The toolbox includes all the tools that you will need to 

make your drawing.       (✓ ) 

11- Microsoft PowerPoint allows you to insert new slide to 

your presentation.        (✓ ) 

12- You must be sure that your computer is updated to 

download Microsoft office 365 bundle.   (✓ ) 

13- Be sure to choose a font size to your poster or billboard 

that is easy to read.        (✓ ) 

14- Choice a complicated font size in the poster make it 

easy to read.        (× ) 

15- When making a poster or billboard you must be sure 

that the audience will be able to easily see your 

information.        (✓ ) 

16- Images should be suitable in sense terms of the content 

you are sharing.       (✓ ) 

 

 

 

 

 

 



 

22 
 

 


